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System Overview
Access Professional Edition System (hereunder referred to as
Access PE) consists of four modules
– LAC Service: a process which is in constant communication

with the LACs (Local Access Controllers – hereafter
referred to as Controllers). AMCs (Access Modular
Controllers) are used as Controllers.

– Configurator
– Personnel Management
– Logviewer
These four can be divided into server and client modules.
The LAC service needs to remain in constant contact with the
controllers because firstly it constantly receives messages from
them regarding movements, presence and absence of
cardholders, secondly because it transmits data modifications,
e.g. assignment of new cards, to the controllers, but mainly
because it carries out meta-level checks (access sequence
checks, anti-passback checks, random screening).
The Configurator should also run on the server; however it can
be installed on client workstations and operated from there.
The modules Personnel Management and Logviewer belong to
the Client component and can be run on the Server in addition,
or on a different PC with a network connection to the server.
The following Controllers can be used.
– AMC2 4W (with four Wiegand reader interfaces) - can be

extended with an AMC2 4W-EXT
– AMC2 4R4 (with four RS485 reader interfaces)
 

 

1
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Restrictions and options
You can use Access PE for systems that do not exceed the
following thresholds for connectable components and
manageable data volume.
– Max. 10,000 cards
– Up to three cards per person
– PIN length: 4 to 8 characters (configurable)
– PIN types:

– Verification PIN
– Identification PIN
– Arming PIN
– Door PIN

– Access variants:
– Only with card
– Only with PIN
– PIN or card

– Max. 255 time models
– Max. 255 access authorizations
– Max. 255 area-time authorizations
– Max. 255 authorization groups
– Max. 16 workstations
– Max. 128 readers
– Max. one I/O extension board (AMC2 8I-8O-EXT, AMC2

16I-16O-EXT or AMC2 16I-EXT) per Controller
– The following restrictions apply to each controller type:

1.1
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Controller AMC2 4W AMC2 4W
with AMC2
4W-EXT

AMC2 4R4

Readers/entrances

Max. readers per
AMC

4 8 8

Max. readers per
interface/bus

1 1 8

Table 1.1: System limits — readers and entrances

Video system — restrictions and options
– Max. 128 cameras
– Up to 5 cameras per entrance

– 1 identification camera
– 2 back surveillance cameras
– 2 front surveillance cameras
– You can configure one of these cameras as an alarm

and log book camera.
 

Offline Locking System (OLS) — restrictions and options
– Max. 256 doors
– The number of entrances and authorization groups in the

authorizations depends on the dataset length that can be
written to the cards.

– Max. 15 time models
– Up to 4 periods per time model
– Max. 10 special days/holidays (from the online system)
– The OLS functionality is only given with card No.1.
 

Notice!

USB devices which are connected at a remote desktop as e.g.

enrollment readers are not supported.
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Installation on one computer
The following figure shows a complete Access PE system
installed on a single computer. Controllers can be connected via
a serial interface. If a dialog reader is used then this is also
connected via a serial interface.

Figure 1.1: System Overview – Single Computer Configuration
 

1.2
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Installation on multiple computers
The following figure shows an Access PE system distributed
across 2 computers. This is particularly beneficial in cases
where the Server to which the Controllers are connected is in a
locked computer room, but the personnel data is maintained,
for example, by the personnel department elsewhere.
The Access PE Client can be installed on up to 16 computers,
which access common data on the Server via the network.
Client workstations can be configured to use two monitors.
Window positions maintained by the operating system, ensure a
familiar operators’ environment across login sessions.

Notice!

After an Unistall for Update check if all files have been

removed from the folder .. :\BOSCH\Access Professional

Edition with the exception of the folder SaveData.

1.3
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Figure 1.2: System overview – Distributed System

System Prerequisites
The installation of Access PE requires:
Operating Systems (one of):
– Windows 10 X64 professional
– Windows 2008 R2
– Windows 2008 Server
– Windows 7

 

1.4
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Notice!

Microsoft Windows XP of all versions is not supported by the

Access Professional Edition 3.1

 
Other software:
– To run the AmcIpConfig application supplied (and the

Bosch Video SDK), you need the .NET Framework 4.0
platform.

– To create and display lists and reports, you must install
Crystal Reports applications.

Separate setups are available on the installation CD.
Hardware Requirements
Both Server an Client require a Standard Windows PC with:
– 4 GHz CPU
– 4 GB RAM at least
– 20 GB free disk space (Server)
– 1 GB free disk space (Client)
– 100 Mbit Ethernet Network Card (PCI)
– Graphical adapter with 1024x768 resolution and 32k colors
– Resolution support:

– 1024 by 768
– 1280 by 1024
– 2048 by 768
– 2560 by 1024

– CD/DVD-ROM Drive
– I/O Expansion Option
– USB Keyboard and Mouse
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General

Introduction
Access PE is an Access Control System which has been
designed to offer the highest standards of security and flexibility
to small and medium sized installations.
Access PE owes its stability and upgradeability to a 3-tier
design: The top tier is the administration level with its
controlling services. All administrative tasks are carried out
here, e.g. the registration of new cards and the assignment of
access rights.
The second tier is formed by the Local Access Controllers
(LACs) which govern each group of doors or entrances. Even
when the system is offline a LAC is able independently to make
access control decisions. LACs are responsible for controlling
the entrances, governing door opening times or requesting PIN-
codes at critical access points.
The third tier consists of card readers which, like the
Controllers, are identical across all BOSCH access controls.
They provide not only a consistently high degree of security, but
also a simple upgrade and expansion path for the system,
protecting previous investments.
Access PE multi-user version allows multiple workstations to
control the system. Customizable user rights levels regulate
access and guarantee security. In this way it is possible, for
example, to maintain card data from one workstation whilst
using another to verify whether an employee is present in the
building.
Access PE offers exceptionally flexible configuration of access
rights, time models and entrance parameters. The following list
gives an overview of the most important features:
Quick & Easy card Assignment

2

2.1

12 en | General
Access PE - Personnel

Management

2015-10 | | Installation Manual Bosch Access Systems GmbH



Cards (up to three) can be assigned to persons either manually
or using a dialog reader connected to a PC via a serial
connection. All assigned cards are active. When upgrading cards
the old card is automatically overwritten and becomes invalid,
thus preventing old cards from gaining access even if those
responsible forgot or were unable to cancel them.
Access Rights (including Group Privileges)
Each person can inherit group privileges as well as having
individual rights assigned to him. Privileges can be restricted by
area and time to an accuracy of one minute. Group privileges
can be used to grant and limit access rights for any or all
cardholders simultaneously. Group privileges can be made
dependent on time models which restrict their access to certain
times of day.
Access tracking
By defining Areas it is possible to track and enforce a correct
sequence of accesses. Even without monitoring, this
configuration makes it possible to display a cardholder's
location.
Anti-Passback
When a card has been read it can be blocked for a defined
period from entering at the same access point. Hence it is
possible to prevent "passback", where a user hands his card
back across a barrier to provide access for an unauthorized
person.
Automatic Cancelation of cards upon Expiration
Visitors and temporary staff frequently require access for a
limited period only.
cards can be registered for a specific time period, so that they
automatically lose their validity when that period expires.
Time Models and Day Models

Access PE - Personnel
Management
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A cardholder can be assigned to specific time models which
regulate the hours in which that person has access. Time
models can be defined flexibly using day models which
determine how specific weekdays, weekends, holidays and
special days deviate from normal working days.
Identification via PIN-Code
Instead of a card a person can use a special PIN-Code to enter.
Verification via PIN-Code
Particularly sensitive areas can be programmed to require
additional PIN-Codes. This protection can in turn be made
dependent on time models, so that, for instance, a PIN-Code is
only required for access during holiday times or outside of
defined working hours.
Flexible Door Management
Flexible parameterization of individual door models allows an
optimum balance between security and comfort. The "shunt" or
alarm suppression period can be individually specified to
regulate for how long a door may remain open. In cooperation
with an alarm system the access point can then optionally be
locked.
Periodic Door Release
In order to facilitate access, door alarms can be shunted to
release doors for specific periods. Door release periods can be
defined manually or automatically via a time model.
Time and Attendance
Access points can be parameterized to record ingress and
egress for time & attendance purposes.
Card Design
The graphical add-in module Card Personalization (CP) is fully
integrated into the Access Control system to allow the operator
to create cards without switching applications.
Assignment of Photos
If the add-in module Card Personalization (CP) is not activated
photographic identification can nevertheless be imported and
associated with cardholders.
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Offline locking system
Areas which are not covered, for whatever reason, by the high-
availability online access control system can nevertheless be
locked offline.
Administration of video devices
Entrances can be equipped additionally with cameras to identify
and track the movements of persons using them.
 

User Login
– Start the user applications using the desctop icons:

Personnel Management

Configurator

Logviewer

Map and Alarm Management

Video Verification

or choose the tools via : Start > Programs > Access
Professional Edition
 
– Start the : Map & Alarm Management application using the

desctop icon  or via : Start > Programs > Access
Professional Edition > Map & Alarm Management.

– Start the : Video Verification application using the desctop
icon  or via : Start > Programs > Access Professional
Edition > Video Verification.

 
– Start the : Configurator application using the desctop icon

 or via : Start > Programs > Access Professional Edition >
Configurator.

 

2.2
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– Start the : Logviewer application using the desctop icon 
or via : Start > Programs > Access Professional Edition >
Logviewer.

 
– Start the : Personnel Management application using the

desctop icon  or via : Start > Programs > Access
Professional Edition > Personnel Management.

 
The system's applications are protected from unauthorized use.
A login with a valid username and password is required in order
to invoke the dialog-based subsystems.

The upper drop-down list can be used to select the desired
interaction language. The default is that language which was
used to install the application. If there is a change of user
without restarting the application then the previous language is
retained. For this reason it is possible for a dialog box to appear
in an undesired language. In order to avoid this, please log in to
Access PE again.
Access PE applications can be run in the following languages:
– English
– German
– Russian
– Polish
– Chinese (PRC)
– Dutch
– Spanish
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– Portuguese (Brazil)

Notice!

All facilities such as device names, labels, models and user-

rights schemes are displayed in the language in which they

were entered.Similarly buttons and labels controlled by the

operating system may appear in the language of the operating

system.

 
If a valid username/password pair are entered then the button :
Change Password appears. This can be used to start a new
dialog to change the password.

The button Start the application checks the user's privileges
and, based on these, starts the application. If the system is
unable to authenticate the login then the following error
message appears: : Wrong username or password!
 

Login via Personnel Management
If the user is already logged into the Access PE Personnel
Management application, and if the user's rights include the
other tools, he can start the : LogViewer, : Configurator, : Alarm
Management and : Video Verification using the toolbar buttons.
 
If the user is already logged into the Access PE Personnel
Management application, and if the user's rights include :
LogViewer, then : LogViewer may be invoked directly using the

 button in the tools list, without requiring a separate login to
the LogViewer application.
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If the user is already logged into the Access PE Personnel
Management application, and if the user's rights include :
Configurator, then : Configurator may be invoked directly using

the  button in the tools list, without requiring a separate
login to the Configurator application.
 
If the user is already logged into the Access PE Personnel
Management application, and if the user's rights include : Video
Verification, then : Video Verification may be invoked directly
using the  button in the tools list, without requiring a separate
login to the Configurator application.
 
If the user is already logged into the Access PE Personnel
Management application, and if the user's rights include : Alarm
Management, then : Alarm Management may be invoked

directly using the  button in the tools list, without requiring a
separate login to the Configurator application.
 

Menu and Tool bar
The following functions can be invoked via the menus, the icons
in the toolbar or specific keyed shortcuts.
 

Function Icon/
Shortcut

Description

 
Menu File

New
Crtl + N

Clears all configuration dialog
boxes (except for default
settings) in order to define a
new configuration.

2.3
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Function Icon/
Shortcut

Description

Open...
Crtl + O

Opens a dialog box to select a
different configuration for
loading.

Save

Crtl + S

Saves changes into the current
configuration file.

Save as...  Saves the current configuration
into a new file.

Activate
Configuration

Activates a loaded configuration
and saves the hitherto active
configuration.

Send
Configuration to
LAC

Propagates saved configuration
changes to the LAC-Service.

List recently
active
configurations

 Opens configurations directly,
circumventing the Open
function's selection dialog.

Exit  Shuts down Access PE
Configurator.

Function Icon/
Shortcut

Description

 
Menu View

Tool bar  Toggles display of the tool bar
(default = on).

Status bar  Toggles display of the status bar
at the bottom edge of the
window (default = on).
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Function Icon/
Shortcut

Description

 
Menu Configuration

General Opens the General Settings
dialog for setting up Controllers
and general system parameters.

Input signals Opens the dialog box for
parametrizing input signals.

Output signals Opens the dialog box for
parametrizing output signals.

Entrances Opens the Entrances dialog for
parametrizing doors and card
readers.

Areas Opens the Area Configuration
dialog for dividing the protected
installation into virtual areas.

Holidays Opens the Holidays dialog box
for defining holidays and special
days.

Day Models Opens the Day Models dialog
box for defining time periods
within a day for the activation of
access functions.

Time Models Opens the dialog Time Models
for defining timezones
dependent on days of the week
or calendar.
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Function Icon/
Shortcut

Description

Personnel
Groups

Opens the dialog box Personnel
Groups for dividing personnel
into logical groups.

Access
Authorization
Groups

Opens the dialog box Access
Authorization Groups for
defining groupings of
authorizations to entrances.

Offline locking
system

Opens the Offline locking
system dialog for configuring
special elements of the
installation (Entrances, Time
models, Authorization groups).

Display Texts Opens the dialog box Display
texts for editing the texts to be
displayed at the card readers.

Log Messages Opens the dialog box Log
Messages for editing and
categorizing log messages.

Additional
personnel fields

Opens the dialog box
 Additional personnel fields  for
defining data fields for
personnel.

Wiegand - cards Opens the dialog box Wiegand-
cards for defining the structures
of card data.

Administering
video devices

Opens the Video devices dialog
for configuring cameras to be
used in video verification.
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Function Icon/
Shortcut

Description

Map Viewer and
Alarm
management

Opens the Map Viewer for an
areal view of maps and control
devices and the alarm list for
alarm handling.

 
Menu ? (Help)

Help topics Opens this help text.

About Access
Professional
Edition -
Configurator

 Displays general information
about Access Professional
Edition - Configurator

General system settings
General system settings are displayed below the list of
controller settings. These are valid for all installations.

 

Parameter Default
value

Description

Country Code 00 Some card data are appended
to the manually entered card
number.

Customer Code 056720

2.4
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Parameter Default
value

Description

Poll interval on
serial
connected LAC
in ms

200 The time interval in milliseconds
between pollings by the LAC-
Service to verify intact
connections to a controller.
Range of values for poll interval:
1 to 500
Possible values for read-
timeout: 1 to 3000

Read-Timeout
on serial
connected LAC
in ms

500

Create TA data
at

00:01 Specification of the time at
which the Time & Attendance
data file should be created.

Export
personnel and
TA data

deactivated When activated this option
causes time & attendance data
to written continuously to the
export file.
When not activated the data file
is created at the time specified
by the parameter Create TA
data at.

The file containing attendance time-stamps is created in the
following directory:
C:\Program Files\Bosch\Access Professional Edition\PE\Data
\Export
Under the name TA_<Current date YYYYMMDD>.dat
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Parameter Default
value

Description

Show welcome/
leaving
message

activated Given appropriate reader type
and settings (Arriving, Leaving
or Check ok in the Entrances
dialog) the reader will display
those welcome and leaving
texts which are stored for the
cardholder in the Personnel
Data dialog of the Personnel
Management application.
Does not apply to Wiegand
readers.

Show
cardholder
name in display

aktiviert Readers with display will show
the Display Name as stored in
the cardholder's Personnel
Data.
Does not apply to Wiegand
readers.

Number of
digits

4 Determines the number of
digits a verification or arming
PIN requires.
This setting applies also to the
door PIN which can be set
during the configuration of
entrances.
Possible values: 4 to 8
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Parameter Default
value

Description

use separate
IDS PIN

 If no separate IDS PIN is set,
then a verification PIN can be
used to arm the IDS.
Only if the check box is
selected do the input fields for
the arming-PIN become active
in the Personnel dialog screen.
In this case the verification PIN
can no longer be used to arm
the IDS.
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Parameter Default
value

Description

Count of retries
before blocking

3 Number of failed attempts to
enter the PIN. If the cardholder
mistypes the PIN this many
times then s/he will incur a
system-wide block which can
only be removed by an
authorized system user
(Personnel Management).
Possible values: 1 to 9

Directory paths
to:
Database
Log file
Import files
Export files
DLL files
Image data
Test-Logging

C:\Program
Files
\BOSCH
\Access
Professiona
l Edition\PE
\Data...
\Db
\MsgLog
\Import
\Export
\Dll
\Pictures
\Log

These are the default paths. The
directories for import, export
and image files can be changed.

 

Notice!

When using Wiegand controllers and readers, in order to use

Identification-, arming- or door-PINs the Wiegand card definition

PIN or Card (Nr. 6) needs to be activated.
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Layout of the main dialog
The dialog consists of the following parts:
 

1 = Menu bar — contains dialog functions displayed
according to the menu order.

2 = Toolbar — contains shortcut keys for the most
important dialog functions.

3 = Title bar — conforms to Windows standard and
contains buttons for minimizing or closing the dialog
window. The name of the registered user appears in
square brackets.

4 = Personnel table — lists all people known in the system
along with their attendance status (authorization and
location).

2.5
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5 = Dialog field — the first time this field is opened or
when no user is logged in, it shows a neutral image
(map of the world). When an entry is selected from the
Personnel list, this person's data is displayed.

6 = Online swipe — lists the last five people (with
database image) that have swiped their cards at the
entrance selected.

7 = Device status — lists the configured devices and
entrances along with their connection status. Enables
door control functions.

8 = Event display — faults are indicated by a flashing red
bar (flashes three times) with details on the cause.

9 = Status bar — displays information on buttons and
menu entries that are controlled with the cursor.
Status display on card personalization program (CP),
dialog readers and LAC service.

When you enable the Video Verification component, additional
facilities will be added to this dialog; see Personnel
Management.
 
When you enable the Video Verification component, additional
facilities will be added to this dialog.
 

Menu and tool bar
The following functions are available via the menus or the icon
buttons.

Function Icon Description

Menu Options

Refresh Refreshes the Personnel list

2.6
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Function Icon Description

Exit  Exits the Access PE Personnel
Management application

Menu Persons

New person Opens a blank personnel and
card data dialog

Modify person Opens the personnel and card
data dialog with the data of the
selected person.

Delete person Deletes the selected person
(after confirming a safety check
dialog).

Transmit selected
person to the LAC
service

 Transmits the selected person's
data to the LAC service and
reports success.

Transmit all
persons to the
LAC service

 Transmits all persons' data to
the LAC service and reports
success.

Set all persons
absent

 Sets all persons absent (after
confirming a safety check
dialog).

Set location of all
persons present
to unknown

 Sets the location of all persons
to unknown and deactivates
access tracing for the next
booking of each person.

View/print reports Calls the dialog for creating
report lists.
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Function Icon Description

 List
control

Restricts the persons shown to
those of the selected group.
 

Menu View

Symbol bar  Toggles display of the tool bar.
Default = on.

Status bar Toggles display of the status
bar. Default = on.

Personnel data:
State
Card No.
Personnel-No.
Company
Personnel Group
Phone
Location

 Choice of columns displayed in
the personnel overview in
addition to symbol and name
columns.
Default = State - Company -
Location

Menu Door management

open door These
functio
ns are
also
availabl
e via

The entrance selected in the
device list is displayed and can
be opened (one-off).
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Function Icon Description

Long-term open the
context
menu
(right
click on
the
desired
door/
entranc
e)

The entrance selected in the
device list is displayed and can
be opened (long-term).

lock door The entrance selected in the
device list is displayed and can
be locked.

Menu Tools

User logon Log in/off Personnel
management.

Execute the
Configurator

Executes Configurator and
transfers data from personnel
management.

Execute log
viewer

Executes Log viewer and
transfers data from personnel
management.

Execute Video
verification

Starts the application for
executing video verification.

Execute Alarm and
Map management

Starts the Map viewer and
Alarm management processing
application.

Video panel Shows four displays in the
dialog field for individual video
camera feeds.

Properties  Opens a dialog box for general
system settings.

Menu ? (Help)
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Function Icon Description

Help topics Opens this help file.

About Access
Professional
Edition -
Personnel
Management

 Displays information about
Personnel Management.

Layout of the main dialog

1 = Menu bar - Contains all dialog functions arranged in
menus.

2 = Tool bar - Contains the most important dialog
functions as icon buttons

3 = Title bar - Conforms to Windows standard and
contains buttons to minimize and close the main
dialog window. The name of the current user is
displayed in square brackets.

2.7
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4 = Device status - List of the configured devices and
entrances along with their connection status.

5 = Message list - List of messages arrived hitherto. The
display can be modified by specific filter settings.

6 = Filter selection - Predefined and customized filters
can be selected from the combo-box.

7 = Alarm activation - Triggers the activation/
deactivation of alarms for messages. An incoming
message can be accompanied by an acoustic signal.

8 = Status bar - Dates of the log files opened. Status of
the LAC Service. Alarm settings.

Menu and Tool bars
The following functions are available for log evaluation via
menus and icon buttons.

Menu Function Icon
button

Description

File Print... Print the log messages
displayed

Exit  Closes the LogViewer
application.

Filter Filter
definition

Opens the message
filtering dialog.

2.8
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Menu Function Icon
button

Description

Continuous
mode on

Starts continuous
message display. This
icon is only active
when the function is
not already running
and the message filter
is set to the current
day.
Continuous message
display is the default
setting.

Continuous
mode off

Pauses the continuous
message display. This
icon is only active
when continuous
message display is
running.

Events
previous
day

Switch to previous
day's messages.

Events next
day

Switch to next day's
messages.

View Symbol bar  Hides/Displays the
tool bar.
Default = on.

Status bar  Hides/Displays the
status bar.
Default = on.

without a menuitem
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Menu Function Icon
button

Description

   

   

? (Help) Help topics Opens this help file.

About
LogViewer

 Opens Help About
Access PE LogViewer.

Enrollment Configuration
Enrollment Readers (RS 232) > Tools > Settings calls a dialog
in which it is possible to perform basic configuration tasks
(activate, modify) from any workstation.
– Administrative workplaces, where persons are assigned

cards, can be fitted with an enrollment reader. This must be
parameterized and configured according to the
manufacturer's specifications, or those delivered with the
device. If an enrollment reader is set up then manual card
checking is deactivated.

The required settings for supported readers are:

Reader name BAUD D P S

DELTA 1200 Prox RS232 9600 8 N 1

DELTA 1200 iClass RS232 57600 8 E 1

DELTA 1200 USB Hitag, Legic, Mifare 9600 8 N 1

DELTA 1200 RS232 Hitag, Legic, Mifare 19200 8 N 1

Rosslare ARD-1200EM USB 9600 8 N 1

LECTUS secure 5000 MD 9600 8 N 1

2.9
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D = Data bits N = none

P = Parity E = even

S = Stop bits O = odd

– Chip card system
Displays the card technology — MIFARE classic and Hitag1
can be used for Access PE.
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– If the system has been installed with the optional Card
Personalization (CP) module then the corresponding check
box is selected in settings. Unchecking this box blocks all
functions for card design/creation.

– In addition the automatic transfer of personnel data via
Connection to the LAC Server is also checked. This box
should always remain checked.

– The display of card information during card assignment can
be disabled here. This display is only necessary when,
contrary to default settings (see General Settings in Access
PE Configurator) card data are required which do not
conform to the company standard settings.

Enrollment via AMC connected readers
Make sure that at least one reader is configured with a Door
Model 06c, which is the door model for enrollment.
Start the Configuration Browser and select a Local Access
Controller (LAC) (e.g. AMC2…)

2.9.1
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Click the Entrances symbol an add a new Entrance reader:
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The dialog window Define Entrance opens:
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In this dialog:
– Enter a Description (e.g. Enrollment Reader AMC)
– Select a LAC and a group ID (GID)
– Select a reader type (e.g. Wiegand)
– Select a number between 1 and 8 as Access Reader

Address
Click OK to conform the enrollment configuration.
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To assign the configured enrollment reader to a specific
workstation, you have to change tot he APE client.
– Select Tool > Properties.

Select an available enrollment reader to activate the enrollment
process.
Confirm that your enrollment reader is online.
If you don’t get an immediate response, restart the Personnel
Management dialog.
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Personnel Management
This dialog is the main application of the workstations. Along
with the data storage and editing facilities, this dialog also
shows the locations of individual people as well as any blocks in
place against them. You can also carry out system monitoring
processes via the door control functions and device state
displays.
 

Persons list
The persons list contains all persons known to the system. By
default surname, first name and company or department are
listed. A separate symbols column gives further details about
status of the person or card as follows:

The person has no card

The person is absent

The person is present

The person is absent and blocked. The dialog
shows a blinking light in addition.

The person is present and blocked. The dialog
shows a blinking light in addition.

3
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The default list view, with columns Symbol, Name, Company/
Dept.) can be customized for each workstation. The menu View
> Personnel Data can be used to add or remove further
columns. Displayed columns are marked with a tick and
reselecting toggles the option on and off.
The following additional columns are available:
– card No.
– Personnel No.
– Company / Dept.
– Personnel Group
– Telephone
– Location (if Areas have been defined)
– Picture

Notice!

The current width of the list box may not allow all selected

columns to be displayed. In this case please adjust the width

and the order of the box and columns to best suit your needs.

The order of columns can be changed by dragging and dropping

the column headers. Increasing the width of the persons list of

course impacts the width of the dialog box to its right.

 
The tool bar contains a combo-box to filter the persons list. By
default all persons are displayed, but this may be restricted to
employees or to visitors.

 
You can add the Picture column to the Personnel list. You can
hide or show the column via the View > Personnel data >
Picture menu.
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As this column is added to the far right, you sometimes need to
scroll through the Personnel list to make it visible. Other
columns may need to be hidden.

Notice!

The images fit the height of the column, so people can be

difficult to identify when the display is small. The main reason

for displaying the images is therefore to enable users to quickly

check which persons do not yet have a photo stored.
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Dialog box for personnel data
If you select an entry in the persons list, that person's data are
displayed in the dialog field to the right.

Apart from displaying the most important personal data various
functions can be invoked from this dialog.

Display/Function Description

Name
(Title - First name - Last
name)

Display only - modifications can be
made using the modification dialog
- Personnel and card data, page 61.

Company/Dept.

Personnel-No.

3.2
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Display/Function Description

Card-No.

Photo

Current Status Absence / Presence display
including date.

Set present, Set absent Depending on current status the
person can be set present or absent
here.

Notes Room for free text notes about this
person. Max. 50 characters.

Memo Room for free text memo to this
person. Max. 300 characters.

Memo preview/ Print
Memo

The memo text can be viewed or
printed according to a predefined
print layout.

Telephone Telephone number or reachability
of this person.

Location Display and modification of the
person's location. Any area can be
selected, as well as the default
value -- unknown --.

Special messages on
the reader

each line of the display can contain
a maximum of 20 characters

Name Person's name as displayed by
suitably equipped readers.

On arrival Special welcome text.

On leaving Special farewell text.
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Display/Function Description

Card status  

– valid
– explicitly blocked
– 3x wrong PIN input
– Selected for

random screening

Display and modification of card
status. The following card
parameters can be set here.

Device status
The third area in the main personnel management dialog,
situated beneath the persons list, is the device status display.
[The Video devices tab is one of the special facilities available
with Video Verification; see Video devices]
[The Video devices tab is one of the special facilities available
with Video Verification.]
Situated next to the list of log messages is the device status
display.

The following symbols reflect device status:

Controller is online.

Controller is offline.

3.3
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Connection to the controller can not be
determined.

Extension board is online.

Extension board is offline.

Connection to extension board can not be
detemined.

Connection to entrance - OK.

Connection to entrance is faulty.

Connection to entrance can not be determined.

Entrance is locked.

Entrance is open / open long-term.

Entrance is open too long / possible intrusion.

Connection to reader - OK.

Connection to reader is faulty.

Connection to reader can not be determined.

Faulty connection are marked additionally by a bar at the
bottom edge of the dialog, blinking red at the dialog start.
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Notice!

The status display of Wiegand readers can be misleading.

Because they are not able to respond to status requests a

parameterized Wiegand reader is shown as online as long as its

controller is online.

 

Controls
This function is only active when the user logged in has door
control rights - User rights, page 94.
This function is only active when the user logged in has door
control rights.
Selected entries in the device status list to which there is a
connection can be given commands via the context menu (right
click) or the menu Door management

The name of the selected entry is read from context.

Open <Entrance> The selected entrance opens
once (for one person).

Long-term open <Entrance> The selected entrance opens
for a longer period.

Lock <Entrance> The selected entrance is
locked.

 

50 en | Personnel Management
Access PE - Personnel

Management

2015-10 | | Installation Manual Bosch Access Systems GmbH



Map Viewer and alarm management

1. Map tree
2. Active location map
3. Device control from the map; controls are shown in the

map
4. Alarm list with event information (incl. video)
5. Device tree with status overview and control elements
Mapviewer features:
– Home map for easy navigation
– Navigation between photo views and floor plans via

hyperlink
– Navigation via device tree structure up to three levels
– Interactive Graphical Maps for alarms with integrated alarm

list
– Live view and door control from the map and device tree
– 128 maps per system
– 64 devices per map
– 64 hyperlinks per map
– Max 2 MB per map
– Map viewer use a standard image format .bmp, .jpg, .png

3.4
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Configuring a map
Start the Map Editor

Klick the  button to add a map.

3.4.1
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The map is shown on the dialog.
– Optionally configure this map as Home Map
Add a detail view, e.g. the canteen, to the map tree.
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– To connect the new Canteen map with the main map, go to
the Shape Tab and select a Rectangle.

– Place the rectangle over the area of the main map that
should be shown as a detail view (shown as a red rectangle
in the example below).

– In the Link to Map Display select the respective detail view,
which is “Canteen” in this example.
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Adding a device to a map
Select the Device Tab and add Devices to the map by pulling
them with the mouse into the map. In the example below the
following devices have been added:
– One Access point
– One Reader
– Two Cameras

 

3.4.2
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– Click a device in the map and resize by holding the mouse
button pressed,

– Click a device and rotate as required using the scroll wheel
of your mouse.

 

Device Types Control elements

Access Point
(Entrance)

Open door

 Open door long-term / Reset door long-
term

 Lock door / Unlock door

 Front Identification Camera

 Back Identification Camera
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Device Types Control elements

 Back camera

 Front camera

  

Reader All Entrance Controls

  

Camera Live Video

 

Device Types Alarms

Access Point
(Entrance)

Door opened without authorization

 Door opened too long

 (* All Reader alarm also reflect as Entrance
Alarm)

  

Reader Reader error

  

Camera N.A.

 
*) These alarm events can be customized by the user. That
means, a user can configure any event as an alarm event using
AcConfig -> Event Log message (Double click on second column
will cause an alarm).

Online swipe
The context menu of the entries in the device states list also
offers the Online swipe function, which opens a pane to the
right of the dialog field.

3.5
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In this area the function displays a history of bookings and
messages for the selected entrance. The last persons to scan
their cards at one of this entrance's readers are listed along with
their archive images, a timestamp and the system’s decision
regarding access.
Additionally any messages not belonging to the categories
Message or Information (except message numbers 61 to 67)

are displayed here marked with the  symbol.
The entrance in question is displayed at the top of the pane.
Even after selecting a different entrance in the device states list,
the online swipe view for the first entrance remains. To switch
to online swipe view for another entrance, you must invoke it
explicitly via the context menu for that entrance
For as long as it is active the context menu contains the line
switch off online swipe, so that the access history can be
hidden again at any time. Notes highlighted in color indicate
whether access was granted (green) or denied (red) in each
case.
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Only the last 5 messages and/or bookings are shown.
While the Online swipe view is active, the display is updated
constantly with new messages, the most recent appearing at the
top.
The list contains only access requests for the current day and
previous day. If no cards were scanned during this period the
list remains empty.
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Personal data
To create a new person open an empty dialog box using the

 button or via the menu Persons > New person

Notice!

Note, this refers to creating a new personnel record. If instead

you wish to edit existing personnel data then double click on a

person in the persons list, or select a person and click the 

button in the toolbar. The same dialog box will be opened, but

containing the data for the selected person.

 

 
 

4
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Personnel and card data
The dialog Personal data and authorizations contains all relevant
personal and card data, as well as special card information. The
minimum inputs for the person to be stored in the database are
a name and a personnel group.
The following information can be stored:

Data field/
Input field

Description

 
Person

 

Title These data appear here in the order Title,
First name, Last name. In the persons list
the title is not displayed.

Last name

First name

Date of birth The date can be entered in numbers or
picked using the spin button (small up/
down arrows).

Company The company or department can be spread
over 4 lines. Line feeds can be entered
using Ctrl + ENTER. Max. 114 characters.

Telephone Also appears as information about the
person's availability. Max. 30 characters.

Valid from ...
to ...

The validity period for access control can be
specified here. Empty fields imply unlimited
validity.

Personnel
group

Input required. One personnel group must
be chosen.

 
Card data

4.1
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Data field/
Input field

Description

(Display of card
status)

Symbolic display of the current card status.

 No card assigned

 Card assigned

Personnel-No. Enter a personnel number of max. 6 figures

1. Card-No. Enter a card number of max. 6 figures
All cards get the same access
authorizations.

2. Card-No

3. Card-No

 
Special messages on the reader

Display name Display text for capable card readers.
Default is First name, Last name. Max. 20
characters

Text on arrival Customized display texts for arrival and
departure can be entered here for TA
readers. Prerequisite is thatthe system
parameter Show welcome/leaving message
is activated in the Configurator settings.
Max. 20 characters.

Text on
departure

 
Access control data

Time model Select an existing duty model. The person is
permitted access only during the defined
periods.
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Data field/
Input field

Description

PIN Input of PINs for use with keyboard readers.
PINs are not permitted to contain
sequences (e.g. 1234) or palindromes (e.g.
0110). General settings for PINs are made
in the Configurator > Settings dialog.

Verification +
Confirm PIN

Input a 4-8 digit PIN (default = 4) which will
be requested after presentation of card at
an entrance, as an additional security
measure.

Identification-
PIN /
ID-PIN

As this PIN needs to be unique system-wide
it is generated by the system and displayed
in a message dialog before saving.

The length of this PIN is between 4 and 8
characters, default value = 4.
This Identification-PIN can be typed at
keyboard readers instead of presenting a
card. As this PIN functions virtually as a
card number it also carries with it all
authorizations assigned to that card
number.

Access PE - Personnel
Management

Personal data | en 63

Bosch Access Systems GmbH 2015-10 | | Installation Manual



Data field/
Input field

Description

Arming-PIN /
IDS-PIN

Input a 4-8 digit PIN (default = 4, the same
length as the verification PIN) to arm the
alarm system.
Whether these fields are displayed or not is
determined by the check box separate IDS-
PIN (Configurator > Settings).
By default the fields for arming/disarming
the IDS (intrusion Detection System) are
not displayed.
If a separate arming-PIN has not been set
then a verification PIN may be used to arm
the IDS. However if a separate arming PIN
has been set then it alone can used - the
verification PIN will not then function as an
arming PIN.

Note: A fourth variety of PIN, the Door-PIN, can be assigned
separately to individual doors. This code must be known to
anyone using the door.
Door-PINs are set and activated in the configurator on the
Entrances page under the function PIN or Card.
 
Important: When using Wiegand controllers and readers, in
order to use Identification-, arming- or door-PINs the
Wiegand card definition PIN or Card (Nr. 6) needs to be
activated.

 
Buttons on the right hand side of the dialog box

Take picture These buttons are only visible when Card
Personalization (CP) (Create cards, page
74) is installed and running on this
workstation.

Preview card

Print card
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Data field/
Input field

Description

Print card
reverse side

Acknowledgem
ent

Import picture Pictures in .jpg or .bmp format may be
imported. The picture is integrated in the
personal data display.

Delete picture Only activated if a picture has been
imported.

Delete card 1 Only activated if a card has been assigned;
changes the display of the card status (see
above).

Delete card 2

Delete card 3

Assign card 1 Assigns a card number to the selected
person and changes the display of the card
status (see above).

Assign card 2

Assign card 3

 

Notice!

The identification and door PIN variants cannot be used for

door models with security system arming (TM 10 and 14).

 

Assigning and revoking cards
Each cardholder can hold up to three cards, which can be
assigned and revoked separately. Depending on the system
configuration, card data can be recorded manually or via an
enrollment reader, but only one of these methods can be active
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at a time: once an enrollment reader has been configured (Tools
> Properties) then manual methods can no longer be used in
parallel.
Manual data recording supports the use of different card
technologies by allowing the operator to change underlying card
bit formats. Once an enrollment reader is used however, only
cards of the same underlying card technology can be used.

Notice!

In Access PE a cardholder can use multiple credentials in

multiple formats and technologies. Each of these however

identifies the same individual with the same set of

authorizations, blocks, PINs, time models and area-restrictions.

Depending on the Properties (Enrollment Configuration, page 35)
cards can be checked manually or via a reader. Only one of
these modes can be active at any one time. As soon as a reader
has been configured the card number can no longer be checked
manually.

Manual card checking
For manual card checking a card number, with a maximum of six
digits in default, must be defined in addition to at least the
minimum personnel data of Name and Personnel Group. Please
enter a valid card-no. for the person!
Clicking Assign card initiates a verification of the uniqueness of
the card number. This card is already assigned to the following
person: xxx
The card number is now encoded based on the default card
data shown in the Settings dialog of the Access PE
Configurator. A successful assignment is signalled by a dialog
box which needs to be confirmed with OK before the data are
stored.
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If Connect to LAC Service is activated in Personnel
Management properties (Enrollment Configuration, page 35)
then changes or additions to personnel data are transmitted
immediately to the LAC service and become valid system-wide.

Notice!

A person must be assigned not only a card number but also the

authorizations (Authorizations, page 68) for all entrances

required.

If the check box Do not show dialog for editing card
information is not checked in Personnel Management
properties then the button Assign card invokes the following
dialog which provides an opportunity to override the default
settings (see Access PE Configurator).
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Card checking by dialog reader.
A connected dialog reader for checking cards must be
configured in Personnel Management Properties. Manual
checking is thereby automatically deactivated.
In this case all data are read in from the card. Keyed input is
therefore unnecessary and will be ignored by the system.
The user is prompted to hold his card over the dialog reader,
from which he will receive either permission to enter or an
error message.
 

Authorizations
This page is only shown if the user currently logged in has
administrator rights (User rights, page 94) to modify
authorizations.
This tab is for the purpose of assigning authorizations to
persons in the access control system. If Configurator (dialog
Authorization groups) has already been used to assign default
authorizations to particular personnel groups, then the person
will have received those authorizations by being assigned to that
personnel group.

4.3
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The user's authorizations can however be supplemented by use
of this tab.

This dialog contains four list boxes. The right hand boxes list all
configured authorization groups (upper list), and all configured
individual entrances (lower list). A person's total authorizations
consist of all authorization groups and all individual entrances
assigned to him in this dialog.
Authorizations (groups or entrances) can be transferred to a
person either by double clicking on one in a right hand list box,
or selecting one and clicking . The  button transfers all
available authorizations at once. Any combination of group or
individual authorizations can be assigned. Conversely, assigned
authorizations can be revoked by double clicking or by use of
the buttons  and .
If authorization groups contain time models (these should be
appropriately named), then the group's assigned entrances are
only passable by that person during those time models. Please
note the special cases in Application of time models *** XRef
ME TO Anwendung_von_Zeitmodellen.xml in Access PE.
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By default authorizations are not limited in time, however it is
possible to limit both group and individual authorizations by
entering dates in the columns valid from and valid to. A click in
a cell in these columns invokes an in-line editor for entering

dates and times: 
Dates can be entered via keyboard or mouse using the spin
controls (small arrows) on the right side of the editor. The space
bar moves the cursor from day to month to year etc.
Furthermore, by right-clicking on an open date field the user can
invoke a calendar date picker, for extra speed and comfort.

In this way, when creating a person, authorizations can be
assigned which will only come into effect at a later date. Thus it
is unnecessary to set a reminder to re-edit a person's
authorizations because these authorizations can be set to expire
automatically on a certain date. If a valid from date occurs later
than a valid to date, then the authorization is deactivated upon
reaching the valid to date and reactivated upon reaching the
valid from date. This feature can be useful, for example, when a
person takes vacation.
Changes to authorizations and other personnel data are not
saved until confirmed by clicking OK. All changes are then
automatically transmitted to the controllers, provided that in
Settings (Tools > Properties) the option Connect to LAC
Service is activated. In special cases the data can be
transmitted explicitly using the menus Persons > Transmit
selected person to LAC service or Persons > Transmit all
persons to LAC service.
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Additional fields
This tab is only visible when at least one of the 10 available
additional data fields has been configured in Access PE
Configurator.
Up to 10 additional data fields can be configured. These can
vary both in number and in field name. The fields can contain
values of up to 40 characters.
The fields are displayed in order. If one of the ten fields is
skipped then a space is left as a placeholder. If that field is
configured later on, then it will replace its placeholder in the
ordering.
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!

Caution!

Each text entry field is assigned a field in the database so that

the data can be stored, selected and included in reports. This

means however that changes to additional data fields which are

in use will lead to the loss from the database of the data they

contain. If the use of the additional field contents does not

change then the name of the field can be changed at any time.

 

Application of time models
Time models which are associated with personnel data will only
be active if the reader's default settings have not been changed,
and the option No time model check thus remains unchecked.
time models can be used in many ways, so in order to
understand how the system handles multiple assignments
please note the following conflict-resolution rules:
If a person has access to certain entrances via a time model, and
if that person is given access to the same entrances without a
time model, then the looser restriction prevails. I.e. in this case
the time model will not be applied.
Example:
A person is given the following access rights:
–

– Access to entrances A, B, C and D within a time model
of 09:00 to 17:00 every day.

– Individual access rights to entrances B and D without
time model.

This person now has access to entrances A and C between
09:00 and 17:00 every day, and unrestricted access to entrances
B and D.
– If a person is given different access rights covering the

same entrances, but governed by different time models,
then the union of the time models is applied.

Example:
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A person is given the following access rights:
– Access to entrances A, B, C and D within a time model of

07:00 to 13:00 every day.
– Access to entrances B, D, E and F within a time model of

09:00 to 17:00 every day.
The person now has access to entrances A and C from 07:00 to
13:00, to entrances B and D from 07:00 to 17:00 and to
entrances E and F from 09:00 to 17:00
– If a person is assigned to an authorization group with time

models, and if the same person is given a time model for
the use of his card, then the intersection of the defined
periods is applied.

Example:
A person is given the following access rights:
– An authorization group with access to entrances A, B, C and

D, and a time model of 07:00 to 13:00 every day.
– An authorization group with access to entrances B, D, E and

F and a time model of 09:00 to 17:00 every day.
– And additionally a duty model of 11:00 to 19:00 every day
The person now has access to entrances A and C from 11:00 to
13:00, and to entrances B, D, E, and F from 11:00 to 17:00.
 

Access PE - Personnel
Management

Personal data | en 73

Bosch Access Systems GmbH 2015-10 | | Installation Manual



Create cards
Access PE is supplied with its own card personalization
program. You can install this software on certain computers of
your choice. To personalize cards, you will also need the
appropriate hardware (camera and printer); we therefore
recommend that you only install these components on the
computers you will use for personalizing cards.
Please note that even the image import function, for example for
displaying images in the personnel dialog, only functions on
computers on which the card personalization program has been
installed and started.
 

Creating cards
The functions required for creating cards can be executed at all
workstations where the Badge Designer program is installed and
running. Buttons for this purpose are found on the tab
Personnel data.

5
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In addition to this the workstation must be connected to the
necessary equipment: a camera and a card printer.
To configure the hardware select the card personalization
configurator with Start > Programs > Access Professional
Edition > Card-Personalization-Configuration.
Paramatrize a camera or a printer with the inputs on the tab
Video respectively Print. Please rever the Online Help of this
tool, too.

The following steps are recommended for the creation of cards:
– Import or take a photo
– Preview card (optional)
– Print card/reverse side
– Print card receipt (optional)
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Taking or importing photos
Personnel Photos, which are to be printed on cards or to appear
in the personnel data dialog, can be taken with a connected
camera or imported from a file, if available.

Importing photos
Photos of employees can be imported as files and assigned to
personnel data.

Notice!

Photo import is also available at workstation where the Card

Personalization application is not installed. In this case however

photographs can only be imported in original size. The editing

features described below are not available.

 
To import a photo from a file click Import picture and pick a file
from the file selector dialog. The configuration settings for the
Card Personalization program define a default directory for
imported files, and this is the first directory opened by the
import function. Nevertheless any picture file on the system can
be found and selected by the file selector dialog.
Once the file has been selected it is shown in the preview
window to aid in finding the correct photograph.

5.2
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Once a picture has been chosen an editing dialog appears which
allows the picture to be cropped and resized. The red frame
marks that portion of the photo which will be stored in the
system for that person.
 

The selected portion of the photo can be repositioned in the
frame by dragging and dropping with the left mouse button.
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The selected portion of the photo can also be enlarged by left-
clicking, holding and stretching with the mouse. In this way even
small portions of photos can be used for cards, provided the
resolution of the photo permits the magnification.
By clicking OK the selected portion of the photo is imported.
 

The frame size will be adapted to the size of the frame in the
dialog window and/or the picture frame in the defined card
layout, and previewed there immediately after confirming the
import.

Taking a photo
The card creation application Card Personalization (CP) must be
configured for the camera type which is attached to the
workstation. This is done using the CP Configuration dialog.
Please consult that application's help facility to find out more
about possible settings.
The following screen shots are taken from Video for Windows
and will not be the same for all camera types.
Clicking on the button Take picture brings up the following
dialog:
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If necessary the current camera settings can be checked and

modified using the  button.
If the settings and the requirements match then the image can
be frozen with the Freeze button.
Live image mode can be activated again at any time if the frozen
image is unsatisfactory. If the photograph is to be used for card
and personnel data then please click Apply.
A further dialog Crop picture is displayed. Using a cropping
frame you can select that part of the photograph which is to
appear on the card.
Please consult the section on Importing photos above for further
details about use of the cropping frame.
 

Previewing and printing cards
The buttons Preview card and Print card reverse side are only
active if card layouts have been assigned to the respective
personnel group in Access PE Configurator (dialog: Personnel
Groups).
 

5.3
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Preview card
After the picture has been taken it is automatically inserted into
the predefined area in the card layout, where it can be
previewed before printing. The card is previewed in the
following dialog box, which is invoked by the Preview card
button.
 

Close the dialog by clicking OK.
 

Print card
If the layout of the card is satisfactory then, in the final step, it
can be printed. The Print card button invokes the following
dialog which resembles the last except that it offers a print
command.
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The Print button begins the print process by invoking a dialog to
choose a printer. If a default printer has been defined in
Configurator then printing proceeds immediately.
 

 

Print card reverse side
If the reverse side of the card is to be printed then special
layouts and contents can be defined for the purpose.
Note: Please ensure that the cards whose fronts have been
printed are uppermost in the hopper of the card printer before
you give the command to print the reverse side.
Tip: We recommend that the reverse side contain only general
and not person-specific data. In this case you can pre-print the
reverse sides of a number of cards and hold them in stock,
making it faster to create complete cards for individuals as the
need arises.
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Printing card receipts
Another feature of the card creation application is the ability to
print a standard receipt. The receipt documents the handover of
the card and the cardholder can receive information about the
data stored on it.
To use this feature a template must be created and stored for
the personnel group in Access PE Configurator, dialog:
Personnel Groups.

 

5.4
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Reports
You can use the list functions in Access PE to collate the
database contents in a specific way and organize them into a
clear format for printing.
To filter the results so that only the data the user needs to see is
shown, you can use pre-prepared layouts, which provide specific
information regarding a certain aspect of access control (for
example, who has what authorizations for which doors).
 

Reports

The  button changes the view from the personnel data view
to a dialog for creating and viewing reports relevant to access
control.

6
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A number of reports layouts and content filters are available:
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Layout Available Filters Description

Personnel
data

Last name
First name
Personnel no.
Card no.
Card no. from ...
to
Dept./Company
Personnel Group

Displays personnel data.
Data can be filtered
according to any or all of
the available filters.
Multiple filters function
restrictively (logical AND).
For example, it is possible
to search for all persons
whose name begins with A
and whose card number is
in the range 900 to 999.
The * character can be
used as a wildcard to stand
for any or no characters.

Blocked
Persons

Last name
First name
Personnel no..
Card no.
Card no. from ...
to
Dept./Company
Personnel Group

Displays data of personnel
whose card status is
anything other than valid
(e.g explicitly blocked, 3x
wrong PIN input, selected
for random screening) in
the main personnel data
screen.
Data can be filtered
according to any or all of
the available filters.
Multiple filters function
restrictively (logical AND).
For example, it is possible
to search for all persons
whose name begins with A
and whose card number is
in the range 900 to 999.
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Layout Available Filters Description

The * character can be
used as a wildcard to stand
for any or no characters.

Persons -
Authorizati
ons

Last name
First name
Personnel no.
Card no.
Card no. from ...
to
Dept./Company
Personnel Group
Authorizations

Report listing persons and
their assigned
authorizations. Group
authorizations are marked
with (G) and individual
authorizations with (E).
Duration of validity is also
shown.
It is possible to filter based
on one or multiple
authorizations. Each
authorization can be
selected or unselected with
a single click.

Persons -
Areas

Last name
First name
Personnel no.
Card no.
Card no. from ...
to
Dept./Company
Personnel Group
Locations

Based on the configured
areas in the system both
the names and the number
of persons at the specified
location are listed.
It is possible to filter based
on one or multiple areas.
Each area can be selected
or unselected with a single
click.
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Layout Available Filters Description

Authorizati
ons -
Persons

Authorizations Report listing authorizations
and their assigned persons.
Group authorizations are
marked with (G) and
individual authorizations
with (E). Duration of validity
is also shown.
It is possible to filter based
on one or multiple
authorizations. Each
authorization can be
selected or unselected with
a single click.

Devices Device type
Device description

Report listing device types
(controllers, entrances,
readers).
It is possible to filter based
on one or multiple device
types. Each device type can
be selected or unselected
with a single click.
Devices can be filtered by
text matches on their
descriptions. E.g. all
devices whose descriptions
start with A.
The * character can be used
in the device description as
a wildcard to stand for any
or no characters.
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Layout Available Filters Description

Users Last name
First name
Personnel no.
Card no.
Card no. from ...
to
Dept./Company
Personnel Group

Report listing persons who
are also users of the system
and the user rights assigned
to them
Data can be filtered
according to any or all of
the available filters.
Multiple filters function
restrictively (logical AND).
For example, it is possible
to search for all persons
whose name begins with A
and whose card number is
in the range 900 to 999.
The * character can be
used as a wildcard to stand
for any or no characters.

Persons -
Doors

Last name
First name
Personnel no.
Card no.
Card no. from ...
to
Dept./Company
Personnel Group
Authorizations

Report listing persons and
their assigned doors. Group
authorizations are marked
with (G) and individual
authorizations with (E).
Duration of validity is also
shown.
Persons can be filtered by
text matches, e.g. all
persons whose names start
with A.
The * character can be used
in the device description as
a wildcard to stand for any
or no characters.
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Reports: Page view
Depending on the choice of layout different fields are activated
for setting filter criteria. These filters limit the report contents to
a subset. If no filter is set then all data are reported. The Search
button triggers the collection of data and their display in a
preview window.

Notice!

When changing filter criteria it is advisable to make use of the

Clear form button to avoid unintentional filtering and hence

misleading reports.

Open log files can be saved or printed. The menu item File >
Print or the button  opens a preview.

 

6.2
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Notice!

All opened log files will be printed.

Close all files which should not printed or reduce the selection

to the important messages.

 
The reports page view offers a number of tools for modifying
and manipulating the display:
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Button Meaning Description

Export The list can be exported to a file
for further processing. The
following formats are available:
Acrobat Portable Document
Format (PDF)
Comma Separated Values (CSV)

Print Prints the report via a print dialog
which allows the setting of a
default printer.

Select page The arrow buttons turn to the
first, previous, next or last pages
of the report. The control also
shows the current and the total
number of pages in the report.

No. of
pages

Prompts the current page and the
number of all pages.

Zoom The standard scale of the view
(100%) can be changed as
desired.

Exporting lists
Press the  button to open a dialog for defining the export
criteria.
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The Format selection list field offers the output formats .pdf
(for forwarding and archiving specific search results) and .csv
(for further processing data).
When exporting data to a csv file, it can be processed to some
extent on the way.

As well as entering the Delimiter and the export Mode, you can
also exclude or isolate Report and Page sections (column
headers and page details) and Group sections (selected data)
from the export.
You can select one of the following options as the Destination.
– Application — opens the file with the appropriate

application. This application must also be installed on the
computer. pdf files are opened with Adobe Acrobat Reader
and csv files are opened with MS Excel.

– Disk file (default) — opens an Explorer dialog for selecting
the directory you require. A name for saving the file is
suggested.

– Exchange folder — the file can be sent directly to an MS
Outlook recipient.

– Lotus Domino Mail — the file can be sent directly to a Lotus
Mail recipient.
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User rights
The rights for users of Access PE applications (as well as users
of the Configurator and the Logviewer) are assigned in
Personnel Management on a special personnel data tab (= User
Rights).
 

User rights
This tab is only visible if the user currently logged in has
administrator rights. Only administrators can set and modify
their own rights and those of others.

If a person is to receive user rights for Access PE applications,
then these must be explicitly assigned. By default all persons
are configured without user rights.

7
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User rights can be assigned by entering a user name and a
password. The person's surname is suggested by default as the
user name, but this is arbitrary. The password can be max. 16
characters long, is case sensitive and may contain any special
characters.

Notice!

It is highly recommended that you create a separate user for

each person who is to use the system. Do not create a generic

user under whose name different persons will work. All data

entries, modifications etc. are logged under the name of the

user who carried them out, but this is only worthwhile if each

user has his/her own password and changes user settings

(User handover and workstation security, page 99) as necessary

when sharing the workstation with another person.

The default installation contains one predefined administrator.
Hence when these predefined users are logged on it is possible
to create and modify any other kind of user or administrator.
Administrators differ from normal users only in as far as they are
able to administrate user rights. There is no difference between
the user types as far as the availability of applications or access
to data and log files is concerned. Each of the users can be
configured with restricted or unrestricted data access.
If one of the administrator options is chosen then the various
groups of user rights for Access PE applications become active
and can be assigned individually.
In detail, the assignable user rights are the following:
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Applicatio
n

User right Description

Personnel
data

View
personnel
data

Only the dialog box with personnel
data can be invoked. Locations of
persons are not displayed.
Modifications are not allowed.

Edit
personnel
data

Personnel data can be viewed and
modified. Locations of persons are
not displayed.

Change
location

Can only be used in conjunction
with one of the above options.
If View personnel data is active
then locations can be displayed
only.
If Edit personnel data is active
then locations can be modified.

Change
authorizati
ons

The tab Access authorizations only
becomes active when this box is
checked.

Configurat
or

Configurati
on of
system

Activates full user rights for
Configurator.

Door
manageme
nt

Open /lock
door (long-
term)

Door management is activated for
the menu of the same name, and
via the context menu in the device
status list (in Personnel
management and Log viewer).

Log viewer View own
message

Filters out all log messages except
those pertaining to the user
himself.
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Applicatio
n

User right Description

View all
messages
without
personal
data

Shows all log messages but masks
personal data.

View all
messages

Shows all log messages
uncensored.

When you are setting up video verification, special rights are
available for authorizing particular people and activities with
regard to controlling and operating video facilities; see User
Rights.
When you are setting up video verification, special rights are
available for authorizing particular people and activities with
regard to controlling and operating video facilities.
Active user rights are marked with a tick in the check box and

the  symbol next to it. The following picture shows the
activation of all rights. All boxes can be checked without fear of
rights conflicts, because the more comprehensive set of rights
will take precedence.
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Setting user access rights
The system is delivered with a pre configured User-
Administrator rights.
A user with the user name and password bosch is provided by
default.
Only administrators are allowed to set up other users.

!

Warning!

This user and his password is part of the standard delivery and

not customized for each purchaser of the software. Therefore it

is urgently recommended, before entering production usage,

that you first use them to set up your own accounts with

administrator privileges, and then delete or modify the original.

Set up further users as follows:
1. Start Access PE Personnel Management using the desktop

icon  or via Start > Programs > Access Professional
Edition, and log in with the pre configured User-
Administrator account.

2. Open the dialog for adding personnel data using the button

 or the menu Persons > New Person
3. Add a new user by specifying at least the name and

personnel group
4. Click on the User Rights tab and…
5.

– change the user name if necessary
– assign a password.
– define the type of the user (User or User-

Administrator).
– assign to this user the rights to modify data.
– Confirm your entries and close the dialog box by

clicking OK.

7.2
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6. Log out of Personnel Management by clicking  or the
menu Extras > Logon and confirming the safety check by
answering Yes.

7. Use the button  or the menu again to log on using the
credentials of the user you have just created.

User handover and workstation security
User handover
If one user relinquishes control to another at the same
workstation then the handover should be made explicitly within
the system. This handover can be performed with a running
system - there is no need to restart Access PE.
First the current user must log out. To do this s/he clicks the

 button in the tool bar. A safety check follows: Do you
want to end your work with user rights?
After confirming the system switches back to the default view.

 

The new user logs in again using the  button.
 

7.3
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Workstation security
In the case of temporarily unoccupied workstations in publicly
accessible places it is crucial to protect personal data from
unauthorized access. Several measures are available for this
purpose:
– In general neither Configurator nor Log Viewer should be

installed on such workstations.
– Log out of Personnel Management when not in use, using

the  button with safety check as described above. The
personnel list remains visible but personal data can no
longer be accessed.

– Close the application using File > Exit, or the Windows x-
button in the title bar. The application will need to be
restarted to view the personnel list.

– Lock the computer using the standard Windows function:
Press Ctrl + Alt + Del and choose Lock Computer from the
system functions offered there. As this is the default
function Lock Computer can usually be quickly achieved by
simply pressing RETURN. Only the current user or a
Windows system administrator can now unlock the system.
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